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1. Introduction
This document covers the basics to get you started with Skalp,  the next exciting must-have extension to
SketchUp.
We hope that you’ll like using Skalp and find this document informative.
If there is anything that you feel should be be corrected, please let us know as we are passionate about
providing a great experience.
Enjoy!

About Skalp for SketchUp 1.1
Skalp has been designed and built as an easy to use yet powerful Live Section Tool.  It represents the key
missing features needed to realize a long standing dream: Create your stunning plans and elevations inside
SketchUp.
 The Skalp development Team has its roots in architecture and 3D software, but that doesn’t mean Skalp is
for architects or Pro users only.  SketchUp is being used in so many disciplines nowadays. Which is why we
intended Skalp to be as ‘generic’ as possible. This means we do not want to change or disrupt your specific
workflow. We feel Skalp should just try to respect whatever and however you’re doing in SketchUp and
simply boost your ability to create superb drawings.

As for the future of Skalp, we thank everybody who has purchased, spoken to us or helped us in any way.
We plan to continue improving Skalp in many ways whilst keeping an affordable upgrade path. We always
welcome new suggestions. If you’d like us to add or change something, by all means feel free to contact us.

Thank You!

The Skalp Team

Contact
To purchase Skalp and/or Skalp Pattern Designer, please visit:
http://www.skalp4sketchup.com

Support questions: support@skalp4sketchup.com
Questions on your purchase: sales@skalp4sketchup.com

Reseller inquiries: reseller@skalp4sketchup.com
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Features

Skalp Sections

• Automatic hatch patterned cross sections.
• Live updates, all model changes are tracked on the fly.
• Use Styles to remap the look in each scene.
• Fully supports nested groups and components.
• Supports multiple drawing scales in one model.
• Neat user interface filled with relevant features.

Skalp Styles

• The same Section represented in multiple ways.
• Each Scene can have its own cross section style.
• Intuitive and powerful mapping queries.
• Assign by layer, material, hatching or tagging.
• Patterns adapt to the drawing scale.

Skalp Pattern Designer

• Make awesome tileable Pattern textures for your Skalp Sections.
• Texturize your model in a new creative way.
• Import standard CAD patterns.
• Build your own patterns from scratch.
• Supports scales, transparency, colors & line widths.

Skalp Export

• Support for SketchUp Pro’s LayOut: Persistent updates of Skalp sections in all scenes.
• Export to DXF includes real CAD hatch patterns.
• Batch export of scenes to DXF.
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2. Preparing Skalp
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2.1. System requirement
• SketchUp Make 2014 / 2015 / 2016 or SketchUp Pro 2014 / 2015 / 2016  Both 64-bit and 32-bit

supported
• Mac OSX 10.9.x or higher + Safari 7.x  

OR
• Microsoft Windows Vista, 7, 8, 10 or higher + Internet Explorer 10 or higher

SketchUp 2014 is not fully supported under windows XP

 Please do not attempt to run Skalp on earlier SketchUp versions, this will not work and is not supported.
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2.2. Installation Notes
1. Download the latest Skalp.rbz version from www.skalp4sketchup.com/dowloads and save it in a folder

of your choice. You may delete this file after the installation procedure below is finished.
2. We recommend logging into your computer as an administrator before installing Skalp for SketchUp.

This will make the installation go more smoothly and ensure that files get installed in the properly.
3. Select: Window > Preferences (Microsoft Windows) or SketchUp > Preferences (Mac OS X). The

Preferences dialog box is displayed.
4. Click on Extensions. The Extensions panel is displayed.
5. Click on the Install Extension button. The Open dialog box is displayed.
6. Locate the downloaded Skalp.rbz. For SketchUp 2016 Skalp is signed as a trusted extension.
7. Click on the Open button. Skalp should appear in the list of extensions and is ready to be activated.

More information on installing plugins in SketchUp
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2.3. First run / Activating Skalp
1. Skalp needs to be activated upon first run.  An internet connection is needed ONCE for this process

to succeed.    
a. Click on one of the  Skalp Toolbar icons.

b.        You will be presented with a dialog where you need to fill in or paste your   license activation
code:  
xxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx  

Skalp for Sketchup Skalp for SketchUp - 3.0
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This code was sent to you via email upon purchase.                  Read the Skalp End User License
Agreement and Check to Accept.    click on Activate Skalp        

2. Skalp will try a fully automatic activation.
a. In case this doesn’t succeed an email is sent to you with your ‘Skalp.lic’ license file. The

license file then needs to be placed manually as follows:
b. C:\Users\YOUR USERNAME\AppData\Roaming\SketchUp\SketchUp 20[14/15]\SketchUp\

Plugins\Skalp_Skalp\Skalp.lic (Microsoft Windows)
c. /Users/YOURNAME/Library/Application Support/SketchUp 20[14/15]/SketchUp/Plugins/

Skalp_Skalp/Skalp.lic (Mac OS X)
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d. To navigate to this hidden folder on Mac OS X: Open a new Finder window, press and hold
the Option (left alt) key on your keyboard, the click Go in the menu bar  > Library >
Application Support > SketchUp 20[14/15] > SketchUp > Plugins

3. Skalp is now ready to use.
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2.4. Updating to a new Skalp version
1. Upon start, Skalp checks to see if a new version is available for download.  If this is the case a dialog

will ask you wether you wish to update or not.    

2. If you accept, a second dialog will explain the process that is about to happen.  Skalp will clean your
current installation. Your ‘Skalp.lic’ license file and any custom hatch patterns will NOT be removed.  
After a successful uninstall you will be redirected to the Skalp Product Downloads page in your web
browser. From there you can always download the latest version.  

3. After successfully downloading you have to reinstall Skalp as described in the Installation Notes.  

4. In case your Skalp BETA or RC has EXPIRED you need to reinstall Skalp manually.  Start by
uninstalling Skalp:  - open the Ruby Console from SketchUps menu and enter ‘Skalp.uninstall’ (without

In case your current Skalp version is a BETA version, its EXPIRY DATE is also shown.  We
strongly advise you to update Skalp before this date passes as you will have to manually
update otherwise.  

!

MAKE SURE TO CLOSE AND REOPEN SKETCHUP BEFORE REINSTALLING SKALP  !
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the quotes). Hit enter. The Console should now state ‘True’, indicating Skalp has been successfully
uninstalled.  - close and reopen SketchUp and proceed with the Skalp installation as explained under
‘Installation Notes’.    

You can manually download the latest Skalp version from:  http://download.skalp4sketchup.com/downloads/
latest

Please understand that your purchased License will NOT expire.  It is just the BETA or RC
builds of Skalp that we need to force an expiry upon in order to make sure you are running
a recent version. During BETA or RC, features may undergo changes.  Make sure to read
the Release Notes section at the end of this document for more information. Thanks for your
understanding.

*
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3. Start Using Skalp
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3.1. User Interface Overview
Click on the Skalp Icon in the Skalp Toolbar to bring up the main Skalp dialog:

1. Activate / Deactivate Skalp Sections
This green/red slider button manages the section visibility. It does this by activating/deactivating the
SketchUp section and by turning on/off the special purpose Skalp layers.
If you want to ‘remember’ this setting on the active scene, you have to use  ‘Save Skalp Settings to
Scene’ (7).  When this slider button is RED and you cannot turn it to GREEN, this indicates no Skalp
Section is available in the model and you have to create one first (2).

2. Add a new Skalp Section
Adds a new Skalp enhanced SketchUp section plane to your model.
Once Skalp is running you can either add new sections with Skalps ‘+’ button or using the standard
SketchUp ‘Section Plane’ tool.Both will produce the exact same result.
After placing the section plane, a dialog allows you to enter a name and create a new Scene to be
associated with the Section. The Scene creation is optional. Skalp Sections can be associated to a
Scene later from the main Skalp dialog as well. Multiple Scenes can be associated with one and the
same Skalp Section. See ‘Using Scenes to manage Skalp Section visibility’  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3. Delete a selected Skalp section
Deletes a Skalp section and removes all Scenes that are associated with the selected Skalp section.
(see ‘Using Scenes to manage Skalp Section visibility’ to manage Skalp scene association.)

4. Force Update a Skalp section
Can be used to recalculate a section. Mainly needed when you have turned OFF Skalp auto updating
from the preferences in the menu. Normally not needed if automatic updating is ON.

5. Drawing Scale
Sets the Scale at which you intend to print the selected Scene. This influences the size and resolution
of the patterns generated by the Skalp Pattern Designer.

6. Show More
Opens up the lower part of the dialog to show the ‘Skalp Styles’ editor.  See ‘Skalp Styles’

7. Skalp Menu

• Save Skalp Settings to Scene
Stores the active Skalp Section Plane and its scale settings in the current scene.

• Update all Scenes (for Layout)
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• Updates all Skalp Sections in all scenes. Brings all scenes in a consistent state, accessible even
when Skalp is unavailable. This is useful for models in Layout or to hand over your model to clients
that don’t have Skalp.

• Export to DXF
Saves a 2D DXF file of the Skalp Section into the same directory where your model is saved.

• Export all scenes to DXF
the same as ‘Export to DXF’ but for all scenes at once.

• Create new Pattern
Opens the Pattern Designer Dialog

• Create Skalp Pattern Layers
Creates a separate layer named ‘Skalp Pattern Layer – ‘ for each Skalp Pattern. This method is
intended for advanced use of SketchUp’s Color By Layer function. See Skalp Styles.

• Define Layer Patterns
Opens a dialog that allows permanent mapping of Patterns to SketchUp Layers. To use this mapping
add a line ‘by Layer’ to your Skalp Style.This mapping information gets stored directly to the Layers in
your active model.  When you save your model as a template, new models based on this template will
inherit this mapping.

• Preferences, Live Updating ON/OFF
Toggles Skalp’s automatic updating. Leave this ON under most circumstances. This option is intended
to turn off Skalp’s automatic updating in case it would slow down your workflow too much. (e.g. on
really big or complex models.) When this option is turned OFF, you have to ‘Force Update’ (4) the
Skalp Section manually. It is always a good idea to try to find and reduce the source of your model
being ‘slow’ before reverting to switching this option to OFF.
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• Preferences, Set Section Offset Distance
Determines the ‘depth’ distance at which the Skalp section groups are offset from the standard
Sketchup section plane. It depends on your model size and your computer’s 3D depth resolution how
small you can set this offset before you begin to see parts of the Section result getting clipped. (e.g.
on a recent macbook pro retina 0.1mm would be ok, on older hardware we recommend at least 1mm).

• Preferences, Set Default Drawing Scale
Stored Drawing Scale (5) preference that Skalp will use when it is loaded next time.
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3.2. Understanding and Using Skalp Sections
A Skalp Section is an ‘enhanced’ SketchUp section.  It adds Live updating and styled solid Fills.
What exactly does this mean, and how is this accomplished?
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3.2.1. Section Fills
In essence, Skalp searches and selects particular sets of faces from the model, intersects them with the
section plane and looks for ‘closed loops’ in the results to fill. Only closed loops can get filled.
Skalp will track and process your model ‘context by context’.  A ‘context’ is a Group, a Component or simply
the Model itself.  So, the process starts by taking your top level context: the model itself.  Next, Groups and
Components are taken one at a time.  The resulting ‘fills’ will be updated and placed into one managed group
in your model.
While not necessary, it is good practice to try to create components and groups that are ‘manifold’, ‘solid’
objects. These objects will be processed faster and are likely to produce cleaner section results. If a
selected object reports a ‘Volume’ in the entity info dialog, this indicates it is a valid solid object.
Skalp does track nested objects. That is: groups or components inside other groups or components. So
organizing your model in smaller nested groups/components might help getting better section results.
 In order to further maximize Skalp’s potential and tailor it to you specific workflow you can step it up and
have special Patterns and/or hatches mapped onto a Skalp section. This can be done using a wide range of
workflows, explained in more detail under ‘Styling your Skalp Sections’.  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3.2.2. Live updating
By default Skalp Sections update automatically when needed. Skalp will track and process all drawing
entities in your model. Whenever something changes, Skalp will either directly update or, in some cases
wait for the next opportunity to update. For example: If you move something, Skalp will wait for the move
tool to end. This is done because SketchUp allows you to specify a distance after a move operation. This
behavior would be broken if Skalp would interfere to soon, so it waits until another tool starts.

To accomplish ‘Live’ tracking, Skalp depends on a mechanism in SketchUp called ‘Observers’. All kind of
actions are tracked in this way:

• Adding, Deleting, Changing; basically all model actions.  Whenever entities in the model, in a group or
in a component are modified, Skalp will update the section.

• Switching Scenes will update the active Skalp section plane for that scene
• Turning layers ON or OFF will be reflected in the Skalp section.
• Hiding or showing model entities will be reflected in the Skalp section.
• Moving the section plane itself is also tracked.

You can disable automatic updating as a preference from the menu on the main Skalp dialog. Manual ‘Force
Updates’ are then needed. Under normal conditions it is advised to keep auto-updating turned ON.
Special care is needed to update all scenes if you want to use your model in Layout or show the model on a
SketchUp version that does not have Skalp installed. See: ‘Update all scenes (for Layout)’

Pressing the spacebar after, for instance, a move or push pull operation will change the
active tool to the selection tool. This will cause Skalp to update.*
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3.2.3. Using Associated Scenes to manage
Skalp Section visibility
Skalp can manage all layer visibility states in each Scene automatically, provided you follow these rules:  

• Always use the section drop down list to select and activate/deactivate your desired Skalp section.
• If you want to have NO active Section in a Scene, switch the green/red slider button to red, OR select

– No active Section Plane – in the main Skalp dialog.
• CRUCIAL: Use ‘Save Skalp Settings to Scene’ from the menu to make sure the Section status is

‘remembered’ in the current scene. This will also save the scale setting to the scene.The Skalp
section is now associated to the current scene.

• Remember: there is no need to touch any of the Skalp Layers, ever.  If you do so anyway, you may get
into trouble.  
Following these rules, simply switching to another Scene will properly hide or show the appropriate
Skalp sections. (There is a known issue on switching scenes where sometimes you have to click twice
on a scene in order to get the Skalp update right. We need to fix this.)  
Try it out by opening the layer dialog. Switch Scenes and see what is happening to the layers. All
Skalp layers are intended to be automatically managed and should not be changed. Doing so may
cause unintended behavior, or you may notice that Skalp simply won’t allow interference by restoring
the layers state.
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3.2.4. Convert an existing Section Plane to a
Skalp Section
You can convert an existing SketchUp section plane to a Skalp Section by selecting the section plane and
then access its context menu by right clicking. Select ‘Create Skalp from SectionPlane’

A dialog will ask you to   enter a name for the new Skalp section. You can always change the name later on
from the main Skalp dialog.
Optionally you can have Skalp Create a Scene and associate it with this Section. This association can also
be managed from the main Skalp dialog.
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3.2.5. Naming and renaming Skalp sections
All Skalp sections in your model can be given a name. To do so you first have to select the Skalp sections
SketchUp SectionPlane in your model.  The drop down list changes into an edit box. Use this field to enter or
change its name. Hit ‘Enter’ to confirm the new name.
On associated scenes the section name will also be propagated: changing the section name will also
change scene names.
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3.2.6. Skalp Layers / Skalp section groups
Skalp dynamically creates , manages and uses a set of Layers and Groups. These all serve very specific
purposes and are essential to Skalps functionality. We strongly advise you not to change, rename or delete
any of these Skalp specific resources ever. Doing so anyway might get you into trouble.  If for some reason
you are feeling a need to modify a Skalp layer or Skalp section group, chances are you’re actually trying
something else that can and needs to be done using another Skalp specific method. Most common
scenario’s are likely visibility handling and naming issues. See:‘Using Associated Scenes to manage Skalp
Section visibility’ and ‘Naming and renaming Skalp sections.’

Purely as a reference, here is an overview:
 Layers Skalp uses:

• ‘Skalp Live section’  This is the layer on which the ‘Skalp active view’ group is placed. It is turned on/or
off using the red/green slider or by selecting either No active Section Plane or a Skalp section from
the drop down list. Its visibility status should NOT be changed manually from the layer dialog.

• ‘SectionPlane: ‘  A Skalp section uses a standard SketchUp SectionPlane object. These parts of Skalp
sections are placed on their own layers.

• ‘Scene: ‘  This is where the ‘Skalp scene view’ section groups are placed. These groups and layers are
where Skalp puts its ‘persistent’ version of the calculated section groups when using ‘Update All
Scenes (for Layout).  

Groups Skalp uses:

• ‘Skalp active view’  The group in which Skalp continuously places and updates its section fills. This
group is normally locked by Skalp. If you unlock it and try to delete it, it is instantly readied to the
model.

• ‘Skalp scene view’  Similar groups containing section fills: one such group for each scene + Skalp
section pair. Only shown in Layout or when using the model in a context where Skalp doesn’t run.
Normally you never see these groups inside SketchUp and as long as you haven’t run ‘Update all
Scenes (for Layout) these groups might not even exist in your model. What you see in SketchUp is
the ‘Skalp scene view’ group.
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3.3. Styling your Skalp sections
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3.3.1. Introduction to Section Styling
Filling a section is one thing, creating real good looking plans is another.
With Skalp Styles you can step it up.

A Skalp Style is similar to a Sketchup style as it is kind of a recipe to determine the look of a Skalp section.

You can opt to go for some real easy basic scenario’s or you can dig in deeper and tailor a style exactly to
your needs.

Some examples:  Suppose you need a floor plan at 1:48 with multiple nice hatchings and colors. You can set
this up using a Skalp Style, store it on a Scene and have that Scene referenced in Layout.  Now, what if you
want to print the same plan on a smaller scale with a simplified preliminary look? Instead of creating a new
Section cut you can now simply duplicate the original Scene and directly start tweaking its Skalp Style. The
section cut itself will still be live and shared across both scenes.

Maybe you need a construction detail with nice hatchings but then adapted to a larger printing scale?

And so on…
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This is what Skalp Styling is all about.

Since all SketchUp users have their own way of working, Skalp offers several workflows to adapt and be
tailored to your use-case. Practical examples are given in a range from very easy and basic use cases, up
to more advanced scenario’s. But first let us look at the Skalp Styles user interface.
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3.3.2. Skalp Styles: User Interface
• The white lower part of the Skalp dialog is where the Skalp Styles are configured and edited. You can

open this part with the ‘show more’ icon.
• A skalp Style can be stored on a Scene by checking ‘save to scene’.
• The complete Style ‘recipe’ is processed line by line, top to bottom.

• The upper two lines represent the default ‘home’ Section style settings. First A Skalp Style will look at
* the entire model and map the Section cut of all elements to a pattern or texture as set here. A
destination Layer can also be set. These settings are always applied, but optional lower rules may still
override them.

• Each new line below the default settings zone represents an ‘override rule’.  Add lines using the small
‘pattern+’ icon  Lower lines can override higher lines as they are processed last.  In ‘edit’ mode, line
orders can be changed by dragging them up and down, or lines can be deleted.

• The left side of each rule tells Skalp what to take as input criteria.  The right side can, for some rules,
determine a specific section mapping.

• All style ruling values can be changed by clicking on them (known issue: sometimes you need to click
twice to access a list). The small icons can be clicked on as well, allowing you to change their
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functions.

• So far for theory, now let’s see how this works in practice and what you can do with all this.
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3.3.3. Styling Workflows adapted to your use
case
Ranging from the most easy options up to some more advanced use cases:  here are some examples to get
you going.
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3.3.3.1. Default Style Settings: one section
material (easy)

When you start using Skalp, you may have noticed your section got filled with the default Skalp
Pattern. The reason lays in the default Pattern Style settings. You can change this by clicking on
‘Skalp default’ as shown:

You may notice your material list will be different. Please see the ‘Pattern Designer’ section on how
to add and manage these Patterns and Materials. What you need to know for now is that beneath
the dashed line you see a list of all standard SketchUp textures in your current model. You manage
these with SketchUp’s material dialog. Above the line is reserved room for the special Skalp
Patterns, to be created with the Skalp Pattern Designer.

You can also change the default destination ‘Layer0’ to another layer. This will place the contents of the
section group result on another layer.
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Be default a line ‘by Object’ is included in this style. This will be explained in a separate scenario. Since
nothing is attached to the groups or components in this example, the ‘by Object’ line can simply be ignored
or removed if you like.
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3.3.3.2. Styling: Pattern ‘by Object’ +
Assigning Patterns to Objects
This is represents the default workflow.

The default style setting will first map everything in the section to the ‘Skalp default’ pattern on Layer0.  Then
the ‘by Object’ rule kicks in and overrides this for all objects that have Patterns setting attached to them.
Each object can have its own Pattern attached.

In this example the block on the left is selected and has been assigned a ‘Brickwork’ pattern. The block on
the right has nothing attached to it and so it will be affected by the default style settings.

Assign Section Patterns or Textures to objects as follows:

When one or more groups or components are selected, the main Skalp dialog changes to allow you to
assign either a ‘tag’ or a ‘material’. Let’s skip tag for now.
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Open up the lower drop down list (‘material’) to bring up a list of all the materials currently available in this
model for assignment. Notice how the list is divided in an upper and a lower part, divided by a dashed line.
The lower part shows all your normal SketchUp materials. The upper part is reserved for Skalp Patterns,
made with the Skalp Pattern Designer. Pick a pattern name from the list.

As an alternative, Patterns can also be attached to groups / components in the current SketchUp selection
set directly from inside the Pattern Designer dialog. Select some objects and the click on the small ‘Pattern
icon to the left of the pattern selector to assign the material.
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3.3.3.3. Styling: Pattern ‘by Layer’ + Assigning
Patterns to Layers
If you organize your models mainly on layer standards, this is the preferred Skalp workflow.

The default style setting will first map everything in the section to the Skalp default pattern on Layer0.  Then
the ‘by Layer’ rule kicks in and overrides this for all layers that have a Pattern setting attached to them.
Each layer can have its own Pattern defined.

In this example the block on the left is placed on Layer0. Since Layer0 has no pattern selected, the default
style settings apply. The middle block resides on Layer1 which has ‘Brickwork’ attached. The block on the
right is placed on Layer2 and therefore inherits the ‘Insulation’ setting.

Assign Patterns to Layers as follows:

From the Skalp menu choose ‘Define Layer Patterns’ to open the ‘Define Pattern by Layer dialog’. The
dialog will list all your model layers. Permanently assign a Skalp Pattern or Texture to a layer by clicking in
its Pattern column and choose one from the list. Remember the upper part of the list represents the Skalp
Patterns you have added to the model before, the lower part represents all Sketchup textures/colors
currently present in your active model.
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Skalp stores these assignments as meta data directly on the sketchup layers themselves. This also
implicates you can choose to pre-define a set of layers with meaningful Patterns attached to them and then
use sketchUp’s ‘Save As Template’ to incorporate this Skalp Styling method into your office standard.
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3.3.3.4. Styling: Pattern ‘by Texture’
A simple ‘solid’ material technique. The section cut will look the same as the material that is painted onto
the group or component.

The default style setting will first map everything in the section: in the example shown this would be the
‘Skalp default’ pattern and placed on Layer0.  Then the ‘by Texture’ rule kicks in and overrides this for all
groups or components that have a Color, Texture or Skalp Pattern ‘painted’ on them.

Each group or component can have its own texture or Pattern painted on it using the standard SketchUp
paint bucket tool.

In this example the block on the left is painted red. The middle group is painted green and .the component
on the right has a Skalp pattern panted on it.  Note that Skalp will only look at textures painted onto the group
or component itself. Materials painted on faces inside groups or components will be ignored.
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3.3.3.5. Style Overrides (refining styles)
Once you know how to set up and use your preferred basic Skalp Style scenario’s, you can start refining
these even further with Style overrides.

You can add several style overrides, and combine them into a customized Skalp Style. You can use
overrides in combination with just the default style settings or even add these as extra rule lines on top of
any of the above described scenario’s.

Style overrides thus provide an extremely powerful method to define style ‘exceptions’. You can remap just
about any combination you like.
 Some examples:
 Remap a pattern to another pattern, Leave a pattern as is, but place it on a specific layer. Colorize some
tagged elements in the section, …

 The combinations are endless: up to you to decide and use as needed.  Let’s see how this works:

To use overrides in general:

• Add a style rule line
• Set the ‘source’: click on its left most icon to set its source type to either ‘layer’, ‘tag’, ‘pattern’,

‘material’ or ‘scene’.

• Just to the right of the chosen source type icon, select the specific source you wish to remap.  
This can be a layer, a tag, a * pattern / SketchUp material or a * scene, depending on the chosen
source type.  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In case of a tag, you need to type in the desired tags to look for. If you want to remap several tag’s at once,
separate them by commas.

• Set the ‘destination’: Choose the destination mapping type by clicking the second icon on the line.
This can be set either to remap to a pattern or to another layer._ (pattern is called ‘hatch’ here in
Skalp version 1.0.0090)_

• Finally select the specific remapping destination: either a Pattern, Texture or a layer depending on the
chosen destination mapping type.
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3.3.3.5.1. Layer
Re-maps a specific layer to either a pattern or another layer.

Here the fixed furniture consists of groups placed on layer ’57 Fixed furniture’. The override rule maps this
to a SketchUp color ‘[0019_Crimson]’ The rest of the section uses the ‘by Object’ method.

This works similar as the ‘by Layer’ method but instead of picking up the mapping directly from the ‘Define
Pattern by Layer’ settings, this method stores individual layer mappings into the Skalp style itself.  As an
example: this could be used to override office standards based on layers without any need to change the
standard layer assignments themselves.
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3.3.3.5.2. Tag
A powerful way to pick up ‘tagged’ objects in your model and style them.

An example: You have a model with a Skalp section completely styled and patterned. If you need a copy of
the same plan showing just a few elements accentuated in red, you can use tags to do so quickly without
disturbing all your other scenes. To assign the tags, select some elements and enter the tags into to the tag
field on the main Skalp dialog. If you want to assign several different tags at once, use commas to separate
them.
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3.3.3.5.3. Pattern
Remap a specific pattern to a layer or another pattern. Same principle as described above under ‘tag’. Picks
up a pattern that is attached to a group or component and remaps it.

Here a group has a pattern ‘reinforced concrete’ attached to it. Using a style override this gets picked up
and remapped to ‘black’.  Tip: When you are using Skalp’s automatic Pattern Scaling feature, all Skalp
Materials will be adjusted to the scale set on the scene. However on some extreme scale settings (large or
small) you might want to use this technique to override some particular autoscaled materials and have them
represented as another pattern or texture. In the example shown under ‘Scaling Skalp sections’, the left
most section shown at 1:100 uses this kind of override rule to remap some patterns to a solid grey
appearance.
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3.3.3.5.4. Material
Pick up a specific SketchUp material, attached to a group or component, and remap this to another pattern
or texture. This works the nearly same as the ‘by Texture’ method, but defined for individual textures only.

Here two SketchUp materials (‘green’ & ‘Matrial1’) that are ‘painted’ onto groups are mapped to Skalp
Patterns ‘Insulation’ and ‘Brickwork’ respectively.
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3.3.3.5.5. Scene
Instead of storing complete Skalp Styles on each Scene you can use this to just reference to a Skalp style
stored on another scene. As such this will make your scene inherit a complete Skalp style from another
Scene. The behavior is dynamic, allowing you to centralize your Skalp styles on a few scenes and reference
them as needed on new Scenes. Changing the original referenced source Style will propagate its behavior
to the Scene using it as a reference.
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3.3.3.6. Copying Skalp styles
Skalp Styles can be copied from one scene to another. The behavior is very similar to copying scene
properties in SketchUp.

Suppose you have a scene ‘Ground floor’ with a Skalp style stored on it that you want to copy over to
another scene ‘Elevation’.

On the ‘Ground floor’ scene this is what your ‘source’ Skalp style might look:

Notice ‘save to scene’ has been checked. This Skalp style is thus stored in the ‘Ground floor’ scene.

Switch to the scene you want to copy your Skalp style to: the ‘Elevation’ scene in this example.

Before proceeding with copying a Skalp style, you might want to check ‘Style overrides : 5.
scene’ as this explains referencing a Style, eliminating the need to hard copy a Style in
some cases.
*
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The ‘Elevation’ scene already has another Skalp style stored, but that is not what you want. So check ‘off’ its
‘save to scene’ setting. This will clear the stored Skalp style from the ‘Elevation’ scene.

If you switch back to the ‘Ground floor’ now, Skalp will look up its stored Skalp style there. Switching
back again to ‘Elevation’, the style from ‘Ground floor’ remains active since no style is stored here any more.

All you have to do now is check ‘save to scene’ on the ‘Elevation’ scene again and you are done copying the
Skalp style.
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To finish up you could align your viewport, switch over to parallel projection, toggle off the SketchUp section
display, adjust the shadows and update the ‘Elevation’ scene. Nice!
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3.4. Scaling and printing your Skalp sections
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3.4.1. Introduction to Section Scaling
A styled Skalp Section offers the key missing link in printing SketchUp based construction documents. On
real professional plans all patterns, hatches and their line widths also need to be tuned and tailored to
your actual print size.

This tedious task is what Skalp scales can automate for you: adapting Skalp materials to specific print
scales: making sure they always look correctly scaled with sharp lines on your printouts. This is what scaled
sections might look like:

An example: The same Skalp section is represented at 3 different scales. The ones at 1/50 and 1/20 share
the exact same Skalp style. They only differ in their scale settings. For each scale used on one or more
scenes in the model, all needed Skalp patterns are automatically adjusted and parametrically maintained.
The section at 1/100 uses a tweaked Skalp style to override some patterns to a solid grey representation.
(see Style Overrides) Note that this example is actually a single screenshot directly taken from a Layout
session. The same one model has 3 scenes referenced. See ‘printing from Layout’

Some things you need to now about Skalp scales:

1. A Skalp scale is a property of a scene.
 As such you can set and change the scale value by clicking on the denominator number on the main
Skalp dialog. If you are using imperial units you could type in ‘48’ to set a scale 1:48 for example.  Just
like the active Skalp section setting, if you want your scale to be ‘remembered’ on this scene, you
need to store this onto your active scene using ‘save Skalp Settings to Scene’ from the menu.
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2. Only Skalp Patterns, created with the Pattern Designer will be influenced be the scale setting.
3. Using scales, multiple scaled textures are generated for the same Skalp Pattern.

 This is normal and by design. We advise you to leave these untouched. If you delete such a material
anyway, Skalp will recreate it upon updating the section.
In the example shown below, the model has several scenes with Skalp sections using different
scales.
 Skalp has added separate tileable materials to your model to support these scales.
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While the added textures look identical in the ‘Colors’ window, a closer inspection shows they are actually
different in placement size. Apart form the %xx part showing their scale, they share the same name. A
pattern intended for a smaller print scale will be placed in the model at a larger size.
In this example ‘parament%200’ is a material to be printed at 1:200.  Placed in the model it will measure
100cm. Once printed at 1:200 it will measure 0.5cm (100cm / 200)
The fact that for scales extra variants of a material are needed also explains why typing in new scale on the
Skalp dialog might take some extra time, adding them to your model. Once a texture is created for a certain
scale, it is stored in the model and will be reused whenever possible. If you have many Skalp sections with
different scales in your model, modifying a Skalp pattern might take more time as well, as all scaled variants
of same pattern need to be processed.
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3.4.2. Scaled printing essentials
Suppose your model is created at a scale 1:1, “real size”. When you are going to print at say a scale 1:20
this action is going to reduce everything by a factor 20. This also means its textures are going to get scaled
down during printing. Now suppose we want a texture that is 2cm wide on paper, printed at a scale 1:20.
How large would the texture need to be in your model? Remember: printing will reduce textures by a factor
of 20. That would result in 2cm/20 => 1mm on paper, which is NOT what we need.  

So to correct and compensate for this effect Skalp will place such a texture scaled exactly 20 times larger
inside a Skalp section defined at 1:20. If you would measure the tile size of the texture in your model you
would find it to be 40cm. This is correct since printing this at 1:20 you would get 2cm on paper as expected.
(40cm/20)

Printing a model at a certain scale can either be done right from inside SketchUp or from a referenced view
of your model inside Layout.  SketchUp printing is essentially limited to printing out scenes while the Layout
option offers an impressive range of superb annotation features.
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3.4.3. Scaled printing from inside SketchUp

To print a Skalp section as intended with sharp lines, its scale,set on the Skalp dialog, must match the Print
Scale setting in SketchUp. Access and set the Sketchup Print Scale from the ‘File > Document Setup…’
panel. You may need to uncheck ‘Fit View to Page’.

Printing in SketchUp will print either your active screen view or what you have stored in your scene if you
print a range of pages at once.

When a Print scale is set, zooming will influence the paper size needed to fit your content.
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3.4.4. Scaled printing from Layout
In Layout, always make sure you select a matching scene from the list of available scenes.

Next, match the view scale on you referenced SketchUp viewport the scale on the Skalp section in
SketchUp.

Check ‘Preserve Scale on resize.

The principle showed above assumes prior knowledge on how to properly reference your model and scale a
scene viewport in Layout.

When correctly configured, a Skalp material will always print razor sharp lines in Layout. (optimized to print
at 300dpi, which is the same resolution Layout uses when its Rendering Resolution Output Quality is set to
‘High’‘.
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3.5. Exchanging Skalp models with others
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3.5.1. Update all scenes for Layout / Pass
your model to Non Skalp SketchUp users

• If you want to pass your model to other SketchUp users that don’t have Skalp, you need to create a
static version of the model that has all sections in all scenes set up with the correct layer visibility
states.

• When yo* u reference your SketchUp model in a Layout file (Layout is available only with SketchUp
Pro), the same static version of your model is needed to keep all all scenes containing Skalp sections
up to date inside Layout.

• It is extremely easy to use: just click ‘Update all Scenes (for Layout)’ in the Skalp menu. This will bring
all scenes in a consistent state and save your model.  Update your model reference in Layout and you
should be done: all your scenes containing Skalp Sections are up to date.

Some technical explanation on what happens behind the scenes here:  Scenes in SketchUp do not actually
store a complete static state of the model, but rather store a sort of a recipe on how to change the active
viewport. When the active viewport changes, lots of things change such as layer and entity visibility states,
camera position etc… For Skalp in order to update, lots of calculations need to be done when a scene
changes. However these calculation cannot actively run inside Layout. Layout does not provide the
necessary extensibility infrastructure for Skalp to run. So ‘Update all Scenes (for Layout)’ works around this
issue by putting a special (normally hidden) Section group in each Scene especially for Layout and
SketchUp instances without Skalp installed.
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3.5.2. Export to DXF
Sorry, this section is currently under construction.
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4. Start Using Pattern Designer
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4.1. User Interface Overview
Click on the Brick Wall like Toolbar Icon in the Skalp Toolbar   to bring up the main Skalp Pattern Designer
dialog:

1. Adds the currently selected Pattern to the SketchUp material dialog. This also prepares the Pattern to be
assigned as a Skalp Section material.  
2. Deletes the material form SketchUp material dialog.
Pattern Scale
 3. Brings up more options to customize the patterns attributes.
 4. Menu: manage import and export of Pattern files.
5. Assignment Icon: assigns the selected pattern to the groups / components in the current SketchUp
selection set.
6. Pattern selector, also allows you to rename the pattern to a custom name.
7. Pattern preview windows with slider to zoom the pattern. Attention: the zooming has no influence on the
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actual pattern scale, use 8 and 9 to set its size.  8. Calibrate the pattern size by changing of the length of the
red X and/ or green Y gauges. Click on these numbers to edit its values. Use small values to start with (e.g.
0.3) to start with, as too large numbers will force skalp to create very large png textures which may be very
slow.
9. and 10. pattern editing features under construction.
11. Pattern Background color. Click to open color picker.
12. Pattern Line color. Click to open color picker.
13. Determine Pattern Line Width. This will change the pattern line width in the generated pattern texture.
(line widths are not yet shown in the preview window.)

Basic tutorial on how to create and assign a Skalp section cut material.
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4.2. What exactly is a Skalp material
A Skalp material is a unique kind of SketchUp texture. Its main use case is to drastically enhance the fills
used in Skalp sections. Its key properties are:

• auto created tileable png texture. Used as a texture it is ‘seamless’.
• based off a vectorial definition: autocad pattern files
• supports line colors, line widths and background colors including transparency
• editable (fully parametric)
• scaleable: auto adapts to different Skalp section scales while preserving sharp and exact line widths

on printouts.
• can be exported to dxf as real vectorial information.
• In a Skalp section they offer a drastical enhancement over standard material textures
• Alternatively it can also be used as a quick and fun way to texturize your SketchUp model.

Key elements in the Skalp material concept you need to understand:

1. A Skalp material is created and/or modified using the Pattern Designer.
2. As input sources it uses a vectorial recipe, supplemented with extra information:  scaling/size data, a

line color, a background color and a line width.
3. The vectorial recipe uses the standard autocad pattern file syntax. Essentially these are just text files

storing one or more ‘pattern definitions’. Each such ‘pattern’ consist of a number of text lines In a
pattern definition the first line always starts with a ‘*’ followed by a name and an optional description.
This is then followed by a series of lines with comma separated numbers representing how a hatch
pattern looks.  It is a relatively simple vectorial data format. You can get these pattern files from several
online sources and directly import them into Skalps Pattern Designer.
A detailed description of the *.pat format will be added to this manual later. The format is well
documented on the internet. Look for *.pat file format. Once you understand the syntax, you could
also create/edit your own custom pattern files.

4. As output a tileable SketchUp texture is added to your model. Once created you can see this texture
in the SketchUp Colors dialog.

5. The entire recipe (pattern definition, as well as its size, colors and line widths) is stored onto the
created SketchUp texture as meta data. This is what makes them ‘parametric’: the ability to edit any
part of the recipe later on using the Pattern Designer.
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4.3. Creating and using Skalp Pattern
Textures
A Skalp material is a kind of SketchUp material. This means that just like any other material in Sketchup it
needs to be available in your model before you can start using it.

So, you need to prepare and add Skalp materials to your model or template at least once. In short, this
process consist of loading a vectorial pattern definition, assigning correct sizes, choosing colors and a
proper line width and than tell the Pattern Designer to create and add the resulting tillable png texture and
its complete recipe to your model as a Skalp material.

Preparing a Skalp Material, step by step:

1. Load a ‘pattern definition’ by selecting it’s name in the the lower part (below the line) of the drop
down list.

2. Once an autocad pattern definition is read a graphical preview is shown. You can now change its
name if you like.

Notice the list is dived in an upper and a lower part, separated by a dashed line. The lower
part represents a list of bare autocad pattern definitions as read from all ‘*.pat’ files in your
SketchUp plugin directory under Skalp/Resources/hatchpats. These bare definitions are not
added to the model and as a consequence cannot be fully used yet.  The upper part of the
list (above the line) might be empty at first, but this is were fully created Skalp materials will
show once available in your model.

*
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3. Define the pattern size.
Autocad pattern files are unit-less. That means they do not have a scale. Inside SketchUp you need
them to show up at a well defined size, so in order to use them, you have to ‘calibrate’ them. To do
so,first click on the ‘Show more’ button to open up the dialog.

4. A Skalp material can be given a size in either Print units or Model units. For use in Skalp sections,
most likely you would want this set on Print units.
When set to ‘Print units’ the sizes given to the gauges will represent the actual lengths as printed
on paper with respect to the scale set on the Skalp section.
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Change the numbers shown directly below the preview. These red and green numbers represent the length
of the red and green ‘gauges’ shown on the preview. The idea here is that you assign a certain length to
either the red or the green gauge. You can type in a number and a unit. e.g. 0.3cm, 2mm or 3/4”. This will
change the scale at which the pattern will be created. In case you would enter a value that is too large Skalp
will refuse to create the texture and rather ask you to enter a smaller size.
You can use the ‘slider’ below the preview to zoom. This currently has no influence on the actual pattern
size, but this implementation will probably change during Skalps beta program.

You should know a Skalp material will always be created to be printed at the scale set on the Skalp section
in your scene. Its line width and resolution (pixels per inch) are calculated and optimized in function of this
print.
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4.4. Using Skalp materials as textures in your
model
When your pattern is set to ‘model units, the sizes given to the gauges will match your actual model units
1:1
Patterns generated using model units will not react to scale changes. They are intended to texturize your
model. As an example you might for instance think of an actual brick pattern at 1:1 shown on an elevation.
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5. Frequently asked Questions
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5.1. General
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5.1.1. Multiple computers
• By default you can activate Skalp on 2 computers per license (e.g. your personal workstation and your

laptop). On these computers you can have multiple SketchUp versions (e.g. SU2016 and SU2017)
using the same license. However, you can only use Skalp on one computer at the same time.

• If you wish to transfer your Skalp license to a third computer, you will first need to deactivate one of
your previous Skalp licenses. Please use the following procedure (you will need an internet
connection): from the top menu choose Extensions > Skalp > Tools > ‘Deactivate on this computer’.
After doing so you can reactivate Skalp using your original license activation code. There is no
limitation on how many times you can transfer your license.

• If you wish to use Skalp on more than two computers, or on more than one computer at the same
time, you will need to purchase additional licenses.
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5.1.2. Activation error

When I try to activate my Skalp version I get the message
that I reached my maximum activations.
Our servers shows that you have already installed Skalp on two different computers. Two SketchUp version
on one computer count only as one computer. If you think this is not the case, We can reset one or more of
your activations. If we need to reset some activation manual from our server, you need to do the following:
Send us a mail from each already activated Skalp version you use at the moment. To send this e-mail use
the following function SketchUp menu > Extensions > Skalp > Help > Contact support. Click on ‘Yes’ when
you are asked to ‘add extra support information’. With this method we can see which activation you don’t
use and we can free up this activation.
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5.1.3. SketchUp Make

Do you need SketchUp Pro or does Skalp also works with
SketchUp Make?
Skalp can be installed and used on SketchUp Make also. Of course you would miss Layout, since that
comes with SketchUp Pro.
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5.1.4. SketchUp 8 or 2013

Can Skalp be installed on SketchUp 8 or 2013?
No, this is not possible. Skalp uses some functionality which isn’t available in older SketchUp version, that’s
why Skalp needs SketchUp 2014 or higher.

Skalp for Sketchup Skalp for SketchUp - 3.0

© 2014-2017 Skalp Page 72 of 97



5.1.5. Trial expired

My Skalp for SketchUp 14-day free version is expired, but I
didn’t got the change to test it. Can I get extend my trial
version?
No, this is not possible. You can only have one free 14-day free trial version on your computer.

Skalp for Sketchup Skalp for SketchUp - 3.0

© 2014-2017 Skalp Page 73 of 97



5.1.6. Education version

Is there an educational version of Skalp?
Our educational program isn’t online yet. The price for Students is 15$ + VAT for one year. Send us a copy
of your student card and we provide you with a link to buy your Skalp Educational version.
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5.2. Sections
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5.2.1. Why are some parts not filled correctly?
In essence, Skalp searches and selects particular sets of faces from the model, intersects them with the
section plane and looks for ‘closed loops’ in the results to fill. Only closed loops can get filled. Skalp will
track and process your model ‘context by context’. A ‘context’ is a Group, a Component or simply the Model
itself. So, the process starts by taking your top level context: the model itself. Next, Groups and
Components are taken one at a time. The resulting ‘fills’ will be updated and placed into one managed
group in your model. While not necessary, it is good practice to try to create components and groups that
are ‘manifold’, ‘solid’ objects. These objects will be processed faster and are likely to produce cleaner
section results. If a selected object reports a’Volume’ in the entity info dialog, this indicates it is a valid solid
object. Skalp does track nested objects. That is: groups or components inside other groups or components.
So organizing your model in smaller nested groups/components might help getting better section results.
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5.2.2. When I change the drawing scale of the
section and update my scene, the scale
settings isn’t saved in my scene?
If you want to save the drawing scale or the active section plane to a scene, you need to use the Skalp
function ‘Save Skalp Settings to Scene’. You can find this function in the menu of the Skalp dialogbox.
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5.2.3. I want to turn off my Skalp section layer,
but it automatically turns on again?
If you don’t want to see the Skalp section. Turn the Skalp active section plane to ‘no active section plane’.
You can do this by clicking the red/green slider in the Skalp dialog box or select ‘no active section plane’ in
the listbox. If you want/need to save this situation in a scene use the function ‘Save Skalp Settings to Scene’
from the menu in the Skalp dialog box.
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5.3. Styles
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5.3.1. How do I use the Skalp Styles?
I sugest to start testing with a simple style instead of making a complex styles. You have 4 simple styles:

1. Only a default material -> everything will be sectioned with the same material.
Video Tutorial – default material

2. By object -> the objects will be sectioned with the material attached to the object
Video Tutorial – by object

3. By layer -> the object wil be sectioned with the material defined to the layer the object is on

Video Tutorial – by layer

4. By texture -> the objects will be sectioned with the same material which is painted in SketchUp on the
group or component.
Video Tutorial – by texture

At first the Skalp styles look complex, but you can use them very simple or you can make them very
complex if you want to do special things. But normally you adapt them once for your own way of working
and you don’t need to look at them anymore.
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5.4. LayOut
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5.4.1. When I look at my Skalp sections in
Layout, the Skalp patterns are all jagged and
blurry.
Skalp materials are optimized to be printed. Layout rasterize everything to 300 dpi (high) or 150dpi
(medium) depending on the Document Setup > Paper > Rendering Resolution > Output quality setting.Even
if you use vector the lines will be rasterized by you printer driver before it’s send to the printer. Only a pen
plotter plots real vector information.

Skalp materials are made at 300dpi considering the chosen scale. This means if you use a skalp material on
the correct scale you get the best result your printer can print. If you zoom in on your screen this texture
look jagged and blurry.

The difference between SketchUp and layout is pure a difference in rendering engine between the two
programs. If you change Document Setup > Paper > Rendering Resolution > Edit quality setting to high you
improve the quality on your screen to 150dpi, but it really slow down your computer! Keep in mind if you set
‘Edit quality’ to high you get 150 dpi, if you set ‘Output quality’ to high you get 300dpi. It is not really
WYSIWYG.
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5.4.2. The color of cut section is shown in a
color instead of black in LayOut. How can I
change that?
How the color of the sectioncut line is defined is depending on your used workflow:

1. With normal use you can define the color in the SketchUp Styles.

2. When you use ‘color by layer’ in combination with hybrid render mode in LayOut, the color is defined
by the color of the layer of the section plane. With Skalp the section planes are placed on layers
called ‘Sectionplane: ‘
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3. When you use ‘color by layer’ in combination with raster render mode in LayOut, the color is defined
by the SketchUp Style.
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6. Trouble Shooting
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6.1. Error: The RubyEncoder loader is not
installed
The problem is Sketchup having troubles with special characters such as ‘ç’ in the user profile path. They
will need to fix this in a future maintenance release of SketchUp. This Sketchup problem will manifest itself
on a lot of plugins from the extension warehouse also.

Currently you can work around as follows:
- create a new user on your computer without any special characters in the name.
- Install and use SketchUp on that users.
- After you have create the new user profile, you may change your user name back to your real name
including the ‘ç’. On renaming a user, Windows will NOT change the actual profile paths themselves, so
everything keeps working.

I do understand this is not an elegant solution, as you end up with either 2 user accounts and having to
switch back and forth. Or you end up having to move a lot of stuff over to the new profile.
For windows 7 Microsoft also explains how to change your existing user profile here:
http://social.technet.microsoft.com/wiki/contents/articles/19834.how-to-rename-a-windows-7-user-account-
and-related-profile-folder.aspx
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6.2. I bought Skalp for SketchUp and got an
activation code, but I can’t activate Skalp. The
activation menu doesn’t work!
Skalp needs Internet Explorer 10 or higher. Even if you don’t use Internet Explorer for browsing the web,
SketchUp extensions uses Internet Explorer for displaying dialog boxes. Update your Internet Explorer
version and your problem is solved.
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6.3. When I click on the extension, the Skalp
window opens up, but then freezes the
program. At this point I am unable to close
the Skalp window, expand the Skalp window
or navigate anywhere within Sketchup
Skalp needs Internet Explorer 10 or higher. Even if you don’t use Internet Explorer for browsing the web,
SketchUp extensions uses Internet Explorer for displaying dialog boxes. Update your Internet Explorer
version and your problem is solved.
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6.4. I have some custom .pat hatch patterns
that were created using hatchkit for ACAD.
These patterns are crashing the program
Converting AutoCAD pattern files to a tileable texture is something very complex to do. At this moment we
can convert 75% of the pattern files to a useable texture. The bigger the pattern file, the longer it takes to
create the texture.
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6.5. I try to activate Skalp for SketchUp and
my computer complains that all my
activations have been used
You are allowed to activate one Skalp license on two computers. If you want to transfer to a third computer,
you need to deactivate one of your Skalp installations. Your computer needs to be connected to the internet
to use this procedure. From the top menu choose: Extensions > Skalp > Tools > Deactivate on this
computer. After doing so you can reactivate using your original license activation code. There is no limitation
on how many times you can transfer your license.

If you get this message and Skalp is not already installed on two computers or for some reason you can’t
deactivate it anymore. Please contact support@skalp4sketchup.com.
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6.6. When change my model it keeps showing
a part of the old section cut
Sometimes skalp looses the connection with the section result in the drawing and doesn’t remove the old
result anymore. Skalp places the new result on top of the old one. You can easily fix this:

1. Turn off Skalp by clicking on the Skalp icon.
2. Select the section result.
3. If the group is locked. Right click and select unlock from the context menu.
4. Delete the group.
5. Repeat 2-4 until you don’t see any section result anymore.
6. Turn Skalp back on and the correct section will automatically be generated.
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6.7. I receive a Ruby Encoder Error?
Remove the Skalp.lic file. And re-activate your Skalp version again with your license activation code.
You can find the Skalp.lice file in your plugins folder ‘Skalp_Skalp’

Windows – the default location is:
SketchUp 2017: C:\Users\YOUR USERNAME\AppData\Roaming\SketchUp\SketchUp 2017\
SketchUp\Plugins
*

Mac OS X – the default location is:
Version 2013 and newer: Open a new Finder window, press and hold the Option key on
your keyboard, the click Go in the menu bar > Library > Application Support > SketchUp # >
SketchUp > Plugins

*
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6.8. The Skalp Pattern Designer can’t be
opened anymore
In some cases importing an incorrect (non autocad pat compatible) pattern file can slip through and still
being imported / copied into your local Skalp installation.
If so, then this file might prevent the pattern designer from starting correctly later on. We need to further
improve our error catching on certain incorrect file types, but this can be tricky.

The way to recover:
Navigate to your plugins folder and locate any custom imported hatch patterns under SketchUp/Plugins/
Skalp_Skalp/Resources/hatchpats/
skalp.pat is the default pattern file, so you can leave that.
Delete other files you have imported that you know are not acad compatible pat files.

Restart Sketchup. You should now be able to start the Pattern designer again.

Windows – the default location is:
SketchUp 2017: C:\Users\YOUR USERNAME\AppData\Roaming\SketchUp\SketchUp 2017\
SketchUp\Plugins
*

Mac OS X – the default location is:
Version 2013 and newer: Open a new Finder window, press and hold the Option key on
your keyboard, the click Go in the menu bar > Library > Application Support > SketchUp # >
SketchUp > Plugins

*
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6.9. Error: TypeError: no implicit conversion
of nil into string in ‘get mac’
It looks like windows ipconfig has trouble finding a valid MAC address on you computer. Skalp is dependent
on ipconfig reporting at least one valid MAC address.
Could you open a windows command line (from the start menu run cmd.exe) and then type:
ipconfig /all

Or, it could be that cmd.exe refuses to run on you system. Then the following should fix the problem:
http://superuser.com/questions/503145/why-ipconfig-does-not-work-on-windows-7
This boils down to adding c:\windows\system32 to your system path so that windows can find cmd.exe
again.

Or if you see a MAC address 00:00:00:00:00:E0 then the following should fix the problem:

1. Click Start, type cmd in the “Start Search” box, right click the cmd.exe, and then click Run as
Administrator.
2. In the Command Prompt, type: netsh int isa set state disabled, and press Enter.
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6.10. Error: #LoadError: cannot load such file
— fileutils
This problem is you aren’t running the latest version of SketchUp 2014. Could you check Sketchup About >
you should have version 14.1.1282 on windows or 14.1.1283 on mac or higher.
If your version is lower, please update your SketchUp 14 version to the latest maintenance release.
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6.11. Error: NoMethodError: undefined
method `startup_check’ for Skalp:Module
Please install Skalp with administrator rights.
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